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1 Introduction 
As part of the Intelligent Mail Data Acquisition System (IMDAS) upgrade, several new features have been 
introduced to help USPS meet its goal of providing near real time delivery notification to its customers.  
The first new feature is the wireless IMD that provides Global Positioning System (GPS) data on the 
location of the IMDs and geo-location of scanned parcels. The second major feature is the introduction of 
the Regional Intelligent mail Server (RIMS) - a cloud based enterprise system that replaces the LIMs at 
large delivery units and provides Local Intelligent Mail server (LIM) capability to all nearly all delivery 
units.  In addition to providing LIM capability to both large and small delivery units, the RIMS also 
provides users with new reports and map displays utilizing the GPS and geo-location scan data that is 
being collected and transmitted by the wireless IMDs. This document describes the user interface for the 
RIMS. 

1.1 Purpose 

This document describes how to use the Regional Intelligent Mail Server (RIMS) Phase 2 user interface. 
This user guide will be available online to users of the RIMS.   

Since the RIMS will have many users performing in many different roles, this guide provides “how to” 
information that can also be used to create training manuals for each of the different user types that will 
be using the system. 

1.2 IMDAS System Overview 

The Intelligent Mail Data Acquisition System (IMDAS) is an enterprise-wide data collection, data 
processing and data distribution system.  IMDAS comprises legacy IMDs, wireless IMDs, Intelligent Mail 
servers and USPS communications resources to provide timely information to USPS and its customers.   

In the past, LIM computers processed information received from IMDs and forwarded it to the National 
Intelligent Mail (NIM) server.  IMDs associated with small office delivery units connected via dial up or 
LAN and transmitted data directly to the NIM. The NIM reformats the data and forwards to other USPS 
applications for analysis and processing.     

Phase 2 of the RIMS replaces the LIM computers.  The RIMS provides LIM capability for all delivery units 
previously using the LIMs.  Small office delivery units connecting via dial up continue to communicate 
directly with the NIM.  Small office unit delivery units connecting via LAN now connect to the RIMS.  
Unlike the LIM computers, the RIMS are centrally located and hosted on the USPS network.  Users 
access the RIMS with a web interface on a standard ACE computer at any location.  RIMS Phase 2 
receives data scanned by both legacy IMDs and wireless IMDs.  The legacy IMDs continue to transmit 
data via a connected cradle.  The wireless IMDs communicates with the RIMS via a peripheral cell phone 
over a 3G cellular network.  The data sent over the 3G network includes GPS information used for geo-
location tracking and business applications.    

The following diagram illustrates the relationships between the wireless IMD device, the RIMS and the 
rest of the IMDAS system components as described above (Figure 1). 

 



IMDAS RIMS Phase II User Guide   Version: 2.10 

Engineering  Package Technology and Visibility   Date:  April 29, 2014 

 

2 

 

Figure 1. RIMS Phase 2 with Wireless and Non-Wireless IMD 

1.3 RIMS Phase 2 Features Overview 

RIMS Phase 2 supports the following features: 

 View data for multiple System IDs (where authorized) 

 Firm Sheets 

o Manage Firm Sheets and Firm Names 

o Print Firm Sheets and  Firm Names 

 Destinations 

o Manage Registered Mail Destinations Names 

o Print Registered Mail Destinations Names  

 Reports 

o Scan Data Reports 

o Manual Entry Report 

o Wireless Scan and GPS Status reports for Supervisor, Area  and District user Roles  

o MSP Report 

o Delta MSP Report 

o CPMS Report 

o Delta CPMS Report 

 Text Messaging 

o Receive National level Text Messages 
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 Configuration 

o Configure IMDs  

o Configure local RIMS local parameters 

o View IMD file versions 

o View RIMS local file versions 

o Create and manage IMD Sensitive Users  

o Print site configuration barcode 

o View all users for a specific System ID 

 Tracking  

o Wireless Devices 

o Wireless Users and Routes 

o Wireless Daily Scan and GPS Report 

o GPS Locations List (Wireless IMDs only) 

o Address User Location Map (Wireless IMDs only) 

o Map Route Tracks (Wireless IMDs only) 

 Printing 

o Print any web page that is viewable 

o Print accountable logs from IMD 

o Print Registered Mail Destination list from IMD 

o Print Registered Mail Dispatch Bill from IMD 

o Print Firm Sheets from IMD 

o Print Firm Name List from IMD 

o Print test page from IMD 

 Administrator 

o Manage Locations/Systems, Users and User Roles 

o Bulk Import Users and Locations/Systems 

o Manage Areas and Districts 

o Export Audit Log 

o Manage RIMS  and IMD Global Configuration 

 GPS Data 

o Collect GPS tracking data from wireless IMDs 

o Access GPS tracking data through web browsers, including current location of Carriers 
holding wireless IMDs and Route Tracks of Carriers with wireless IMDs 

 Geo-location data 

o Collect new geo-location scan record from wireless IMDs 
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o Plot mail piece scans on a map (wireless IMDs only) 

     eAccess Automation 

o Automatically add, modify and revoke users that are authorized and authenticated 
through eAccess 

 Links to other USPS systems, data, and documentation 
o Track and Confirm – USPS intranet version 
o MSP Application 
o CPMS Application 
o End of Day report 
o On-line User guide 
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2 RIMS Basic Operation 
The RIMS is a menu driven system with user access privileges determined based on role.  The RIMS 
supports six roles: Clerk, Supervisor, Area coordinator, District coordinator, Headquarters and Admin.  
The privileges for each of these roles are outlined in this section with more detail provided in Sections 3, 
4,5, 6, 7,and 8 of this document.     

The RIMS functionality is organized by “module”.  For example Scan Reports are included in the Reports 
module, and Firm Sheet functions are included in the Firmsheet module. The user can access modules 
by clicking on one of the named menu Tabs which are displayed to a user after login.  The user sees only 
those Tabs associated with its assigned role.  For example a user assigned the Clerk role can access the 
Home, Firmsheet, Reports, and Destinations modules.  The Supervisor can access these modules as well 
as the ones for Messaging, Configuration, Tracking and Special Reports.  All roles can access the Home 
Tab.  There are 11 modules assigned to 6 User Roles in various combinations.  These combinations are 
shown in the table below.   

 

 Clerk 
Area 

Coordinator 
District 

Coordinator 
Headquarters Supervisor Administrator 

Home x x x x x x 

Firmsheets x    x  

Reports x x x x x  

Destinations x    x  

Messaging     x  

Config   x  x x 

Tracking  x x x x  

Area  x     

District   x    

Special  x x x x  

Admin      x 

Table 1.  RIMS User Roles and Module Access 
 

Some users are permitted to access data for several System IDs (locations).  They may view data for only 
one System ID at a time.  Different rules apply to Headquarters, Admin, District, and Area roles.  These 
differences are discussed in the sections of the document that identify and describe the specific functional 
modules accessible to those roles.   

2.1 User Log-In Procedures 

RIMS locally maintains user account data including username, first name, last name, user role, active or 
disabled, administrative rights and associated location (system ID). Only users that have been authorized 
through eAccess can successfully log into the RIMS.  Both the user role and the number of systems the 
user can access are approved by the IMDAS Program Management Office (PMO) when the user applies 
for access to the RIMS through eAccess. 
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All users must have a valid username (ACE ID) and password to log on to the RIMS.  USPS Active 
Directory will authenticate users before granting them permission to access RIMS.  Users begin the RIMS 
login process by opening a web browser and navigating to https://rims-imdas.usps.com. Enter username 
and password.  Then select the Login button.  The password is case sensitive and must be entered 
exactly as written.  

  

 

Figure 2. RIMS Log-In Screen 

2.2 Home Tab 

The Home Tab page is the first one displayed to every user after successfully logging in to the RIMS.  
This page includes a Welcome Banner that shows the user’s name and the current System ID to be used 
for the user’s RIMS session.  It also includes the modules (Tabs) that the user can access, and a Set 
Default System ID feature that permits the user to change the System ID so that data for a different 
System ID can be viewed.  This feature is useful for a Postmaster or Supervisor that has responsibility for 
several different System IDs.   Special messages from the IMDAS Program Management Office or the 
Administrator are displayed under User Notifications. 

A sample Home Page is displayed below showing these features. This sample page is specifically 
tailored for the Clerk role.  The Home pages for the other roles will differ slightly as they include the Tabs 
that are accessible to that role. 

https://rims-imdas.usps.com/
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Figure 3.Sample User Home Page 
 

THE FOLLOWING INSTRUCTIONS DESCRIBE HOW TO CHANGE THE DEFAULT SYSTEM ID 
1.) If not on the Home Page, select the HOME Tab. 
2.) The currently assigned System ID is visible in the Welcome Banner. 
3.) Go to the Set Default System ID box and click the down arrow to view the available selections. 
4.) Choose a different System ID from the drop down list and click the Set button to the right of the drop 

down box. 
5.) The screen will refresh and the new System ID will appear in the Welcome Banner. 

2.3 Other Navigation Features 

When the user clicks on any Tab other than the Home Tab, a secondary menu labeled “Shortcuts” is 
displayed and provides the user with a list of functions that can be selected for that functional module.  In 
the Page Navigation Example shown below, the screen shows a Supervisor page with the Firmsheet Tab 
selected.  The Shortcuts menu on the left of the screen lists that functions that a user can perform on 
Firm Names and Firm Sheets.  

In this example, the Firm Names Shortcut was selected, resulting in a table being displayed with a list of 
Firm Names. 
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Figure 4.Page Navigation Example 
 

2.3.1 Sorting Records 
On this page, as in many others displayed by the RIMS, the data is presented in table format.  Certain 
tables are sortable.  Others are pre-sorted based on USPS criteria.  For ones that are sortable, click the 
header of the column that you wish to sort.  The table will re-order based on your selection.  An arrow will 
appear next to the column header indicating the direction of the sort.  The selected column header text 
will darken and change to all capital letters. In the example shown, the Firm Names were sorted in 
ascending order (A-Z) as denoted by the upward arrow next to the column header. Clicking on the column 
header again would sort and present the Firm Names in descending order (Z-A). 

2.3.2 Data Table Navigation 
For most tables, twenty records can be viewed on a single screen.  To view additional records, use the 
page controls “Next” and “Previous” to navigate to other records.  “Next” and “Previous” are located in the 
upper right corner of the table.  Additionally, the numbers between “Next” and “Previous” allow the user to 
move to specific pages of table data.  The number of items displayed on the screen and the total number 
of items in the table is shown at the top of the table next to the word “Results”.   

Some functions will allow the user to view up to 200 records on a screen without navigating to the next 
page.  For these functions, use the scroll bar on the right of the table to navigate through the list of 
records.   

2.3.3 Selecting a Date 
On screens where a date can be entered, click on the date text box that you want to set.  A calendar will 
appear with the current month displayed.  Select the desired date from the calendar and the date will 
appear in the text box.  If you want to select a date in a different month, click on the left arrow to view the 
previous month and on the right arrow to view the next month.  When you have reached the desired 

Column header 

Table Navigation – Next, Previous, and 
page number  
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month, select the desired date and it will be entered in the text box in standard date format which is 
mm/dd/yyyy. 

2.3.4 Other RIMS Information 
Note that the page displayed also includes the following RIMS information items in the upper right corner.  
This information is displayed on every user screen.   

 The version number of the RIMS 

 A phone number for contacting the Help Desk  

 Link to the User Guide (which will be available online).  

 Sign Out - for exiting the RIMS 

 

2.4 View and Manipulate Saved Reports Using EXCEL 

The RIMS gives the user the option of saving RIMS reports for later use or for archiving.  The save report 
feature is available for many of the RIMS reports and is referred to as “Export to CSV”.  When export is 
requested, the RIMS saves the report in the comma separated value (CSV) file format.  This format 
includes a line for every row in the report, followed by a carriage return and line feed.  The data fields in 
each row are saved as text strings followed by a comma to separate the fields.  The file is saved in a 
location selected by the user.  The user also has the ability to tell WINDOWS to save the file in text (TXT) 
format by changing the extension (.csv) on the filename to (.txt) before clicking Save.  The TXT file has 
the same format as the one saved as a CSV file.   

It is USPS common practice to use EXCEL for viewing, manipulating, and printing data in saved RIMS 
reports.  When importing a saved report into EXCEL, it is important to ensure that the data is imported in 
the correct format.  If the user does not instruct EXCEL as to what format the data fields are to be saved, 
EXCEL selects a format for the data based on its own rules.  For example when a data field is all 
numerals or numerals with an embedded decimal point, EXCEL assumes that the data is a number and 
treats it that way.  This can be problematic for data fields that appear to be numbers but are not intended 
to be handled that way by USPS.  Examples of problem fields include but are not limited to:  

 Labels,  
 Zip codes.  
 Employee number,  
 Device ID,  
 GPS data.   

Bar code labels pose a problem when the label is all digits and is very long.  When categorized as a 
number, EXCEL represents these labels in scientific notation (example 8.21E+21) because EXCEL has a 
limit on the size of the numbers that it represents as integer.   

Zip Codes, Employee Numbers, Device ID, GPS data, and possibly others are problematic because they 
often have leading zeroes which need to be retained.  When treated as a number, EXCEL removes the 
leading zeroes.  For example Zip code “00281” would be shown as “281”).  For this reason the user has 
to explicitly tell EXCEL that these fields are to be treated as “text”. 

Following are the instructions for correctly importing saved report files into EXCEL so that problems 
described above will not occur 
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For “csv” files using EXCEL 2010 

1. Create a new document in EXCEL 
2. From the toolbar on the top of the screen, select “Data” 
3. From the Data toolbar, select “From Text” 
4. From the Import Text File pop up window, select the CSV file to import and click on Import 
5. The Text Import Wizard appears 
6. From the Step 1 screen, check Delimited as the file type and then click Next 
7. From the Step 2 screen, check the Comma delimiter box and uncheck all others if they are 

checked; then click Next 
8. From the Step 3 screen, select the data format for each of the columns.  For problematic fields 

identified above and for others in question, select TEXT as the format.  The column being 
selected will be highlighted.  Use the scroll bar on the bottom to navigate through all of the 
fields.  Click Finish when completed. 

9. From the Import Data pop up screen, select the worksheet where the data is to be placed and 
the data will appear on the selected EXCEL worksheet 

 

For “csv” files using EXCEL 2003 

1. Create a new document in EXCEL 
2. From the toolbar on the top of the screen, select “Data” 
3. From the Data toolbar, select “Import External Data” then select “Import Data” 
4. Select the CSV file to import and click Import 
5. The Text Import Wizard appears 
6. From the Step 1 screen, check Delimited as the file type and then click Next 
7. From the Step 2 screen, check the Comma delimiter box and uncheck all others if they are 

checked; then click Next 
8. From the Step 3 screen, select the data format for each of the columns.  For problematic fields 

identified above and for others in question, select “Text” as the format.  The column being 
selected will be highlighted.  Use the scroll bar on the bottom right to navigate through all of the 
fields. When completed, click Finish 

9. From the Import Data pop up screen, select the worksheet where the data is to be placed and 
the data will appear on the selected EXCEL worksheet 
 

If the file was saved as a TXT file rather than a CSV file, follow the instructions below. 

1. Launch EXCEL and under the File tab, select Open 
2. In the box next to File name, use the scroll down arrow to select “Text Files” so that files with 

the .txt extension will be displayed. 
3. Select the file to open and click Open 
4. The Text Import Wizard appears 
5. From the Step 1 screen, check Delimited as the file type and then click Next 
6. From the Step 2 screen, check the Comma delimiter box and uncheck all others if they are 

checked; then click Next 
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7. From the Step 3 screen, select the data format for each of the columns.  For problematic fields 
identified above and for others in question, select TEXT as the format.  The column being 
selected will be highlighted.  Use the scroll bar on the bottom right to navigate through all of the 
fields. When completed, click Finish and the data will appear on the EXCEL worksheet 

 

2.5 Contact RIMS Help 

All RIMS screens include software version information and help support.  The User Guide link and RIMS 
support phone number are in the upper right corner of every screen.  Click on User Guide Help to 
download the user guide, or dial the RIMS help number for additional support.   

 

 

Figure 5. RIMS Help Links 

User Guide and Help Phone Number 
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3 Clerk User Role 
The Clerk User has access to the following Tabs: 

 Home 

 Firmsheets (system based module) 

 Reports (system based module) 

 Destinations (system based module) 

Only these four navigation tabs will be visible to the logged in Clerk user.  

3.1 Home Tab 

When the Clerk logs on to the RIMS, the Clerk Home Tab will be the first screen displayed.  See Section 
2.2 for a detailed description of the Home Tab. 

 

Figure 6.Clerk Home Tab 

3.2 Firmsheets Tab 

The Firmsheets Tab allows the user to create, view and edit Firm Names, Firm Sheets, and the 
associated mailpieces for each and associated with their Locations (System ID).  Additionally, the 
Firmsheets Tab allows user to print Firm Sheets, Firm Names and Import/Restore Firm Names.  The 
information is only displayed for the Location (System ID) set by the user on the Home Tab.  When the 
user logs in and clicks on the Firmsheets Tab, the Firm Names page will display first.   
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Figure 7. Firmsheets Tab 

3.2.1 Firm Names 
The user may view, edit and add Firm Names associated with the current Location (System ID) noted in 
the Welcome banner.  The user will also be able to print the Firm Names list.  The Firm Names list is 
sortable by clicking on the column header.  The arrow will change position to indicate the direction of the 
sort. 

The Firm Names page includes a grey Print button, a Firm Name Search panel and a Results table.  By 
default, the Results table lists all Firm Names with a checkbox next to each one.  When a search is 
performed, the Results table includes the Firm Names that meet the search criteria.  The Firm Names are 
hyperlinked to the Edit Firm Names page. 

CREATE A FIRM NAME 
1.) Click the Shortcut link “Create Firm Names” 
2.) The Create Firm Names page displays. 
3.) Type the new Firm Name in the Firm Name text field 
4.) Click Save to add the new Firm Name to the list, or Cancel to discard changes and return to the Firm 

Names page. 

EDIT OR DELETE FIRM NAMES 
1.) Click a hyperlinked Firm Name.  The Edit Firm Names page displays 
2.) To edit the existing Firm Name, click the text field and type any changes.   
3.) Press Save to commit the Firm Name change, or Cancel to discard the changes. 
4.) Press Delete to remove the Firm Name from the list.  A prompt will appear, asking the user to confirm 

or cancel deletion.  Click OK.  The Firmsheets Tab will display again, but without that Firm Name. 
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Figure 8.Firmsheets Tab - Edit Firm Name 

SEARCH FOR A FIRM NAME 
1.) On the Firm Names page, click on the Firm Name Search box. 
2.) Type in all or part of the Firm Name, then press Search button. 
3.) All matches will appear in the results table below the Firm Name Search box. 

PRINT SELECTED FIRM NAMES  
1.) Select one or more Firm Names to print by selecting the checkbox next to each Firm Name. 
2.) Click the grey “Print selected Firm Names” button. 
3.) The results will display as a PDF file.  Print the PDF using the same steps used to print any other PDF 

or print via the browser like any other web page. 
Note:  Only Firm Names checked on the current screen will be printed.   

PRINT FIRM NAMES DISPLAYED ON CURRENT PAGE 
1.) Click the checkbox next to the column header “Firm Name”. Note that all Firm Names on the current 

viewing page will have their checkboxes marked. 
2.) Then click the grey “Print selected Firm Names” button. 
3.) The results will display as a PDF file.  Print the PDF using the same steps used to print any other PDF 

or print via the browser like any other web page.   
Note:  Only Firm Names checked on the current screen will be printed 

PRINT COMPLETE FIRM NAMES LIST  
1.) Click on the Shortcut link titled “Print Firm names List” 
2.) The Firm Name List with barcodes will display as a PDF. 
3.) The results will display as a PDF file.  Print the PDF using the same steps used to print any other PDF 

or print via the browser like any other web page. 

EXPORT FIRM NAMES TO A CSV (COMMA SEPARATED VALUE) FILE 
1.) On the Firm Names page, click the header “…” 
2.) A drop down box will display.  Choose option “Export to CSV”. 
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3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 
export CSV file. 

4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 

IMPORT/RESTORE FIRM NAMES FROM A CSV FILE 
1.) Click on the Shortcut link titled “Import/Restore Firm Names List”. 
2.) Click the Browse button to find the CSV file you wish to Import. 

Ensure that the file selected to import is not open by another application. 
3.) Click the Header Row box if the file includes a header. 
4.) Click Cancel to return to the Firm Names page 
5.) Click Import to add new Firm Names and update Existing Firm Names from the import file. 
6.) Click Restore to delete all Firm Names on the RIMS and import all Firm Names from the import file.  

 

Figure 9.Firmsheets Tab - Import/Restore Firm Names File 
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Figure 10.Firmsheets Tab - Firm Names Import/Update/Restore Message 

3.2.2 Firm Sheets 
The user may view and print Firm Sheets associated with its Location (System ID).  The Firm Sheets 
page includes a Print button, Firm Sheet Search panel and Results table.  The Firm Sheet Search panel 
includes Firm Name, Start Date and End Date search criteria. 

VIEW FIRM SHEETS 
1.) Click the Shortcut link titled “Firmsheets” 
2.) The Firm Sheets page displays 
3.) Enter a Start Date and End Date in the Firm Sheet Search text field or use the pop up calendar to 

select Start and End Dates 
3a.) Pop up calendar will display after clicking on the Start Date or End Date text field.  Click on a 

date to select.  Use the right and left arrows to navigate by month.   
4.) Note: The Firm Sheet Search field Firm Name is optional.  Leave the Firm Name field blank to pull up 

all Firm Sheets within the specified date range. 
5.) Click on the Firm Sheet Label ID hyperlink to see the List All Firm sheet Mailpieces page. 
6.) This page lists all Mailpieces and their Event Timestamps associated with the selected Firm Sheet. 

6a.) The Event Timestamp is the time the label was entered on the Firm Sheet 
7.) Click the browser’s back button to return to the Firm Sheet search results. 
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Figure 11.Firmsheets Tab - View Firm Sheets 
 

 

Figure 12.Firmsheets Tab - View Firm Sheet’s Associated Mailpieces 

PRINT A FIRM SHEET 
1.) Follow the steps outlined in the previous section (“View Firm Sheets”). 
2.) Click the blue Print link next to any Firm Sheet Label ID to print that Firm Sheet 
3.) To print multiple firm sheets, click the checkbox next to the Firm Sheet.  Then click the grey “Print 

selected Firm Sheets” button at the top of the Firm Sheets page.  
4.) The Firm Sheet will display as a PDF.  Use normal procedures to save or print the PDF file.   

EXPORT FIRM SHEET LIST TO A CSV (COMMA SEPARATED VALUE) FILE 
1.) On the Firm Sheets page, click the header “…” 
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2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 

 

3.3 Reports Tab 

The Reports Tab allows the user to view all Scan Records associated with their Location (System ID) in 
several report formats.  The records are available for viewing on the RIMS for 45 days from the scan date. 
There are five (5) report views that can be selected via the Shortcuts menu.  The differences between 
each of the five reports are the column display order and the sort order; otherwise the same data is 
presented in each report.  Since the columns of each report are pre-sorted, the columns on each report 
are not sortable by the user.   

The five reports as well as other features of this module including:  

 Link to USPS Track and Confirm,  
 View the location on a map of where a specific label was scanned, and  
 Export scan records to a CSV file 

 are described below. 

 SCAN RECORDS BY LABEL 
1.) Click the Shortcut titled “Scan Record by Label” 
2.) The Scan Records by Label page displays. 
3.) Select a Start Date and an End Date.  A specific label may also be entered in the text box to the left of 

the date entry text boxes if you want to retrieve scan data about that label only.  Then click “Search”. 
4.) All Scan Records for the specified date range are displayed, sorted first by Label ID, then by Event 

Date and then by Event Time.  All sorts show data in ascending order. 

 

Figure 13.Reports Tab – Scan Report Ordered by Label 

SCAN RECORDS BY DEVICE ID 
1.) Click the shortcut titled “Scan Record by Device”. 
2.) The Scan Records report by Device ID displays. 
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3.) Select a Start Date and an End Date.  A specific label may also be entered in the text box to the left of 
the date entry text boxes if you want to retrieve scan data about that label only.  Then click “Search”. 

4.) All Scan Records for the specified date range are displayed, sorted first by Device ID, then Route ID, 
then Event Date/Time.  All sorts are performed in ascending order. 

 

Figure 14.Reports Tab – Scan Report Ordered by Device 
 

SCAN RECORDS BY ROUTE ID 
1.) Click the shortcut titled “Scan Record by Route”. 
2.) The Scan Records report by Route ID displays. 
3.) Select a Start Date and an End Date.  A specific label may also be entered in the text box to the left of 

the date entry text boxes if you want to retrieve scan data about that label only.  Then click “Search”. 
4.) All Scan Records for the specified date range are displayed, sorted first by Route ID, then by Event 

Date and then by Label ID.  All sorts are performed in ascending order. 
 

 

Figure 15.Reports Tab – Scan Report Ordered by Route 

SCAN RECORDS BY ZIPCODE 
1.) Click the shortcut titled “Scan Records by ZIPcode”. 
2.) The Scan Records report by ZIP code displays. 
3.) Select a Start Date and an End Date.  A specific label may also be entered in the text box to the left of 

the date entry text boxes if you want to retrieve scan data about that label only.  Then click “Search”. 
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4.) All Scan Records for the specified date range are displayed, sorted first by ZIP code, then by Event 
Date and then by Route ID.  All sorts are performed in ascending order. 

 

 

Figure 16.Reports Tab – Scan Report Ordered by ZIP Code 

SCAN RECORDS BY DATE 
1.) Click the shortcut titled “Scan Records by Date”. 
2.) The Scan Records report by Date displays. 
3.) Select a Start Date and an End Date.  A specific label may also be entered in the text box to the left of 

the date entry text boxes if you want to retrieve scan data about that label only.  Then click “Search”. 
4.) All Scan Records for the specified date range are displayed, sorted first by Date, then by Route ID, 

and then by Label ID.  All sorts are performed is ascending order. 
 

 

Figure 17.Reports Tab – Scan Report Ordered by Date 
 

On each report, the Label ID is hyperlinked to the Track and Confirm application.  The Track and Confirm 
application is not part of the RIMS.   

 

VIEW TRACK AND CONFIRM DATA 
1.) Click on the hyperlinked Label ID for any Label on any Scan Record Report. 
2.) The Track and Confirm page opens in a new browser tab or window showing the status of the mail 

piece with the selected Label ID. 
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3.) To return to the RIMS click on the “x” in the upper right corner of the screen to close the Track and 
Confirm application and return to the Scan Reports page of the RIMS. 

 
Note that some labels in the displayed Scan Report have an entry in the MAP column.  For these Labels, 
GPS mapping data is available and you will be able to view on a map the location where the mailpiece 
with that label was scanned.   The instructions for viewing this data follow.   

VIEW MAP DATA 
1.) Find a Scan Record with the hyperlinked text “map” in the Map column.  Click on the hyperlinked Map. 
2.) The Scan Record location is displayed on a Map.   
3.) To zoom, scroll mouse up/down or use the zoom feature on the left side of the map. 
4.) Click the red pin to see detailed information for the Scan Record point.  Use the scroll bar on the right 

side of the Scan Record Point pop-up to view all available fields. 
5.) Click the “x” in the upper right corner of the pop-up to close the pop-up. 
6.) Click browser’s back button to return to the Scan Record results. 

 

 

Figure 18.Scan Record on Map and Scan Record Point 
 

The user may export any Report to CSV by clicking on the column header “…” on the far right side.  Save 
the CSV file on a local machine and open the file with Excel or a text editor application. 

EXPORT SCAN RECORDS TO A CSV (COMMA SEPARATED VALUE) FILE 
1.) On the Scan Records page, click the header “…” 
2.) A drop down box will display.  Choose option “Export to CSV”. 
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3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 
export CSV file. 

4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 

3.4 Destinations Tab 

The Destinations Tab allows the user to view, edit, add, and delete Registered Mail Destinations 
associated with their Location (System ID).  The Destinations page includes a grey print button to print 
the Destinations list.  The Destination Name and ZIPcode (9 digit) will be viewable, and the user can 
search based on Destination (Name) or ZIPcode.   

 

Figure 19.Destinations Tab - Default Page 
 

 

Figure 20.Destinations Tab - Create Destinations 
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CREATE DESTINATION 
1.) Click the Destinations Shortcut called Create Destinations 
2.) Enter the required information in the fields provided: Destination, ZIP Code and Plus 4.  All fields are 

mandatory.  No special characters, blanks or duplicate 9 digit ZIP codes allowed.  All Destination 
Names will display on the Destinations page as uppercase, regardless of what the user enters in the 
Destination Name field. 

3.) When complete, click Save to save the newly created Destination or Cancel to discard any changes 
and return to the Destinations page. 

EDIT DESTINATION 
1.) On the Destinations page, click one of the hyperlinked Destination Names. 
2.) The Edit Destinations page displays.  Make changes in any of the three fields: Destination, ZIP Code 

and Plus 4. 
3.) Click Save to save changes or Cancel to discard changes and return to the Destination page. 

DELETE DESTINATION 
1.) On the Destinations page, click one of the hyperlinked Destination Names. 
2.) On the Edit Destination page, click the Delete button 
3.) Destinations page returns without that Destination. 

PRINT SELECTED DESTINATIONS 
1.) On the Destinations page, click the checkbox next to each Destination Name you wish to print. 
2.) Click the grey button called Print selected Destination Names. 
3.) A PDF file will display with the selected Destination Names.  Print the PDF as you would print any 

other PDF file by clicking File and then Print from the Adobe menu. 
Note:  Only Destinations checked on the current screen will be printed 

PRINT ALL DESTINATIONS DISPLAYED ON CURRENT PAGE 
1.) On the Destinations page, click the checkbox next to the column header “Destinations”. Note that all 

Destinations on the current viewing page will have their checkboxes marked. 
2.) Then click the grey “Print selected Destinations” button. 
3.) The results will display as a PDF file.  Print the PDF using the same steps used to print any other PDF 

or print via the browser like any other web page.   
Note:  Only Destinations checked on the current screen will be printed 
 

PRINT COMPLETE DESTINATION LIST  
1.) Click the Destinations Shortcut called Print Destination 
2.) A PDF file called Registered Mail Dispatch Destinations List opens in the browser. 
3.) Use the print operation normally used to print from a web browser.  For Internet Explorer browsers, 

click File and then click Print. 
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EXPORT DESTINATIONS TO A CSV file 
1.) On the Destinations page, click the header “…” 
2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 

IMPORT/RESTORE DESTINATION NAMES 
1.) Click the Destinations Shortcut called Import/Restore Destination List. 
2.) Click the Browse button and locate the CSV file you wish to import or restore.  Important note: Make 

sure that the selected file is not currently open and in use on the computer. 
3.) If there is a header row in the file, click the checkbox “Header Row”. 
4.) Click the Import Button to import the file.  Importing will add new Destination Names in the file and 

update existing Destination Names according to the selected file.  A confirmation page will display, 
noting how many Destinations were imported or restored successfully. 

5.) Click the Restore Button to restore the file.  Restoring will delete all Destination Names currently on 
the RIMS and import all names from the selected file.  A confirmation page will display, noting how 
many Destinations were imported or restored successfully. 

6.) Click Cancel to discard any changes and return to the Destinations page. 

 

 

 

Figure 21.Destinations Tab - Import/Restore Destinations List 
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4 Supervisor User Role 
This section describes the capabilities and procedures applicable to the Supervisor User.  The Supervisor 
User Role includes access rights to the following modules: 

 Home Tab 

 Firmsheets Tab 

 Reports Tab 

 Destinations Tab 

 Messaging Tab 

 Config Tab 

 Tracking Tab 

 Special Tab 

Users may navigate between the modules by clicking on the tabs directly above the Welcome Banner. 

4.1 Home Tab 

When the Supervisor successfully user logs on to the RIMS, the Supervisor Home Page is displayed.  
Whenever the Supervisor wants to change the System ID being viewed, he/she must return to the Home 
Tab to select another System ID. 

   

Figure 22.Supervisor User Role - Home Tab 

4.2 Firmsheets Tab 

See Section 3.2 for description of the Firmsheets Tab. 

4.3 Reports Tab 

See Section 3.3 for description of the Reports Tab. 

4.4 Destinations Tab 

See Section 3.4 for description of the Destinations Tab. 
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4.5 Messaging Tab 

The Messaging Tab permits the user to view available text messages.  There is one shortcut available on 
this Tab that permits the user to view text messages sent from the NIM.   

 

Figure 23. Messaging Tab – NIM Messages 
 

VIEW NIM MESSAGES 
1.) Click the Shortcut link titled “NIM Messages” to refresh the screen if necessary. 
2.)  All NIM Text Messages are displayed along with the characteristics of the messages. 

 

4.6 Config Tab 

The Config Tab permits the user to access the following functions: 

 Manage Local Site Settings 

 Print Site Configuration Barcode 

 Manage IMD Configuration 

 View IMD File Versions 

 Manage RIMS Local Configuration and View File Versions 

 Manage IMD Sensitive Users 

 Create IMD Sensitive Users 

 View Web Users 
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Figure 24.Config Tab - Default Screen 

4.6.1 Local Site Settings 
The Local Site/Systems Settings page contains editable configuration parameters that pertain to the 
System ID displayed on the Welcome Banner on the Home Tab. The bolded field names indicate that all 
fields are required.  The Local Site parameters include: 

 Finance Number 

 SFAS Number 

 Origin Facility Name 

 Delivery Unit Phone Number 

 Unit ZIP Code 

 Unit ZIP Code Plus 4 

 Time Zone 

 Daylight Savings Time Observed 
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Figure 25.Config Tab - Local Site Settings 

TO CHANGE TIME ZONES 
1.) Click the drop down box arrow for the Time Zone parameter. 
2.) Choose an option from the drop down list. 
3.) Click Save to save changes, or Cancel to discard them. 

TO ENABLE OR DISABLE “DAYLIGHT SAVINGS TIME OBSERVED” 
1.) Click the drop down box arrow for the Daylight Savings Time Observed. 
2.) Choose Yes or No from the drop down list. 
3.) Click Save to save changes, or Cancel to discard them. 

TO CHANGE LOCAL SITE PARAMETERS 
1.) Click on the textbox of any Local Site parameter. 
2.) Enter the new information.  Each text field will prevent the user from entering more than the number of 

maximum acceptable characters. 
3.) Click Save to save the changes, or Cancel to discard the changes 
4.) Note: If the user enters information in a text box that is not acceptable, a red error message will 

display below the text box.  The red error message will provide more information to help the user 
enter acceptable information in the text boxes. 
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4.6.2 Print Site Configuration Barcode 
The Print Configuration Barcode page allows the user to print a 2D configuration barcode for 
automatically configuring IMDs for their specific Location (System ID).  The System ID will be the same as 
the System ID currently displayed in the user’s Welcome Banner.   

 

Figure 26. Config Tab - Print Configuration Barcode 

TO PRINT A CONFIGURATION BARCODE  
1.) Click the shortcut called Print Site Config Barcode 
2.) A PDF file with Print Configuration Barcode will display either in the web browser or in Adobe, 

depending on the user’s local machine setup. 
3.) Print the PDF file as you would print any other PDF file. 

4.6.3 IMD Config 
The Manage IMD Configuration page provides the user with several IMD configuration parameters.  Most 
are viewable and editable.  The three groups of IMD parameters include: 
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 IMD Printing Parameters 

o Print Mode 

o LAN Printer IP Address 

o Printing Retention Period (Days) 

o BT Printer Address 

o Print In Queue Retention Period (Hours) 

 IMD Communications Parameters 

o Transmission Start Time 

o Transmission End Time 

 

 

 

Figure 27.Config Tab - IMD Configuration 

TO SET THE IMD PRINT MODE: 
1.) Select Bluetooth, LAN, Both, or None from the Print Mode drop down box. 
2.) Enter a valid LAN and/or Bluetooth printer address in the format indicated on the screen. 
3.) Click Save. 
4.) Dock the IMDs associated with the set System ID.  The new print configuration parameter updates on 

the IMDs when docking cycle completes successfully.   
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4.6.4  IMD File Versions 
The IMD File Versions page allows the user to view current configuration file versions for associated 
IMDs.  The read-only list of IMD files and file versions will include: 

 Invalid 3 digit ZIP File Version 

 NIMS IP File Version 

 NAS Phone File Version 

 Public Key File Version 

 Country Codes File Version 

 International Rates File Version 

 Flat Rate File Version 

 Express Mail Domestic File Version 

 Express Mail Insurance File Version 

 Express Mail Cod File Version 

 Return Receipt Rates File Version 

 International Service Country File Version 

 Express Mail Corporate Account File Version 

 Federal Agency File Version 

 International Flat Rates File Version 

 International Insurance Fee File Version 

 Express Mail Corporate Account Delta File Version 

 Express Mail Zone File Version 

 Express Mail Zone Flat File Version 

 Sunday Holiday Delivery File Version 

 Barcode Definition File Version 

 IMD Software Version 

 IMD OS Image System Version 

 Cradle Software Version 

 Cradle OS Version 

The RIMS IMD File Versions screen includes this list of files, their current version, and a cancel button.  
Clicking the cancel button returns the user to the initial Config page.  A sample File Versions screen shot 
is shown below.  The version numbers correspond to the date on which the screen shot was captured 
and may not be the same as the ones shown on your screen on any given date. 
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Figure 28. IMD File Versions 

4.6.5 RIMS Local Configuration and Versions 
The Local Configuration Versions page allows the user to view local configuration parameters.  There are 
three groups of parameters: Log Parameters, Text Last Message ID parameters and RIMS Local File 
Version parameters.  The Virtual LIM Config and Versions page is primarily read-only. Only the Log 
Parameters are editable. The following fields are viewable on the page: 

 Enable Logfile Upload from IMD 

 NIM Last Message ID 

 Last Message ID 
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 Firm Names File Version 

 Destinations File Version 

 Sensitive User File Version 

 

 

Figure 29.Config Tab - RIMS Local Configuration and Versions 

TO ENABLE OR DISABLE LOGFILE UPLOAD FROM IMD: 
1.) Click the drop down box arrow next to Enable Logfile Upload from IMD. 
2.) Choose Yes to enable the logfile upload, or No to disable the logfile upload. 
3.) Click Save to save changes, or Cancel to discard changes. 

4.6.6 IMD Sensitive Users 
The Sensitive Users page displays all the IMD Sensitive User accounts for the current System ID.  It also 
permits the Supervisor User to view and edit the user permissions on these accounts, delete an account, 
and temporarily disable or enable an account.   

Supervisors may search the Sensitive User accounts by User Name.  Below the User Search box, there 
is a list of Sensitive Users.  The list includes User name, Employee ID, SAFR Enabled, Registered Mail 
Enabled, Supervisory Enabled and Enabled (active user).  For each of the four Sensitive User fields, 1 
indicates enabled and 0 indicates disabled.  Each column is sortable in ascending or descending order by 
clicking on the column header.  The selected column header will bold, capitalize and the arrow will 
indicate the direction of the sort.  Any changes made to the Business Sensitive User information on the 
RIMS will not take effect on the IMDs until the IMDs have been docked and has received the updated 
Sensitive User list and permissions. 
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Figure 30. Config Tab - IMD Sensitive Users 

SEARCH FOR A USER 
1.) Enter all or part of a User Name in the User Name Search box. 
2.) Click the Search button to execute the search or clear to start over. 
3.) When the Search is complete, the list of matches will display in the Results table below the Users 

Search panel. 

 

 

Figure 31.Config Tab - Edit Sensitive User Sample Screen 

EDIT AN EXISTING USER 
1.) Click on a hyperlinked User Name from the Results list to display the Edit Sensitive User page 
2.) Make the required changes.  Note that Employee ID must be a unique number.   
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3.) Click Save to commit the changes or Cancel to discard the changes.  

DELETE AN EXISTING USER 
1.) Click on one of the hyperlinked User Names from the Results list. 
2.) Edit Sensitive User page displays 
3.) Click the Delete button 
4.) The IMD Sensitive User page will return without the deleted Sensitive User in the list. 

EXPORT THE LIST OF IMD SENSITIVE USERS TO A CSV FILE 
1.) On the IMD Sensitive Users page, Click the header “…”  
2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 

 

4.6.7 Create IMD Sensitive Users 
To create a new IMD Sensitive User, click on the Config Shortcut “Create IMD Sensitive Users”.  The 
Create Sensitive User page displays.  The Create Sensitive User page includes the following fields: 

 User 

 Employee ID 

 Pin 

 SAFR Access 

 RegMail Access 

 Supervisory Access 

 User Enabled 

All fields are required.  Employee ID must be unique.  Save or Cancel changes by clicking on the Save or 
Cancel button located beneath the Sensitive user fields.   
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Figure 32.Config Tab - Create Sensitive User 

4.6.8 View Web Users 
To view the RIMS user accounts with default set to the Supervisor’s current System ID, click the Config 
Shortcut “View Web Users”.  The User Accounts page will display.  Each column is sortable.  The View 
Web Users page includes the following User Account fields: 

 Username 

 Name 

 User Role 

 Active 

 Created By 

 Modified By 
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Figure 33.Config Tab - View Web Users 

TO SEARCH FOR A WEB USER 
1.) Enter all or part of a Username in the Username text field in the User Search panel. The search 

criteria should be constructed using all UPPER CASE letters. 
2.) Click Search to execute the search or clear to start over. 
3.) The results table will populate with matching usernames.   

TO EXPORT THE LIST OF WEB USERS REPORT TO A CSV FILE 
1.) On the User Accounts page click the column header “…”  
2.) A drop down box will display.  Click on “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 

4.7 Tracking Tab  

The Tracking Tab allows the user to view MSP, CPMS and wireless status reports and the position of 
Carriers in near real time and to view the detail of related data presented in a number of different 
contexts. The Tracking Tab opens automatically to the Summary of Wireless Users and Routes.  The 
information is only displayed for the Location (System ID) set by the user on the Home Tab. All Tracking 
Tab pages have the Shortcuts menu on the left side of the page.  The Shortcuts on the left side of the 
page include: 

 MSP Records 

 MSP Delta Report 

 CPMS Records 

 CPMS Delta Report 

 Wireless Daily Scan & GPS Status Report 

 Wireless Users and Routes (Default Page) 
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 Wireless Devices 

 Map Route Tracks 

 Map Address and User Location 

 GPS Locations 

 

Figure 34. Tracking Tab - Default Page 

4.7.1 MSP Records 
The Managed Service Points (MSP) shortcut allows the user to view MSP scan records for the current 
Location (System ID).  On selecting the shortcut, all MSP scan records for the current date are displayed.  
The records are displayed in ascending order based on the Event Date and Event Time taken from the 
MMD record.  MSP records for other dates may be viewed by entering the desired dates in the date text 
boxes and clicking on Search.  It is also possible to selectively view all MSP scan records for a particular 
Route.  This is done by entering the route number in the Route text box and then clicking on Search.   

The USPS MSP Application is accessible from the MSP Record Report by clicking on the hyperlinked 
“MSP Application” above the Record Search box.  The MSP Application will open on a new page. 

 

All RIMS MSP records contain the same twenty two data elements taken from the MMD record and the 
associated header record (MEH).  MSP records are stored on the RIMS for fourteen days.  Records older 
than fourteen days are deleted.  If MSP data is required for future reference, the user has the option of 
exporting the current records to a file in CSV format.  The exported file can be opened and viewed using 
EXCEL. The fields included in each MSP record, their order within the record, and their source are shown 
below: 

 Barcode ID 

 Assignment ZIP  

 Event Date Time  

 Route ID  

 User ID  

 Record Version  

 Barcode Input  

 Record Version (MEH) 
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 Event Date Time (MEH) 

 Finance Number  

 SFAS Number  

 Unit ZIP  

 Device ID  

 Software Version  

 Operating System Version  

 BIOS Version  

 Transmission Date Time  

 Vehicle ID  

 Vehicle Begin Mileage  

 Vehicle Enroute Mileage  

 Vehicle End Mileage  

 Delivery Mode  

 Map 

The MSP Records page is searchable by any of these three fields: 

 Route ID 

 Start Date (default to today’s date) 

 End Date (default to today’s date) 

 

 

Figure 35.Tracking Tab - MSP Record Report 
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Each record that has GPS data associated with it has a link (called “Map” in the Map column).  Clicking 
on the “Map” link displays the location on a map where that MSP record was scanned.   The location is 
marked with a red pin.  Clicking on the red pin displays a scrollable pop up box with geo-location data 
details about the location.  To close the pop-up box, click on the “X” symbol in the upper right hand 
corner.  The pop-up includes the following fields: 

 Label ID 

 User ID 

 Route ID 

 Geo-location Date and Time Stamp 

 Accuracy (feet) 

 Latitude 

 Longitude 

 Method  

o 0 = obtained between first scan and commit 

o 1 = obtained after empty records were created 

o 2 = obtained from previously received data 

 Delivery Mode 

o 1 = In Office 

o 2 = On Street Motorized 

o 3 = On Street Walking 

o 4 = On Street Motorized Wireless, interface type cradle 

o 5 = On Street Walking Wireless, interface type cradle 

o 6 = In Office, interface type wireless 

o 7 = On Street Motorized, interface type wireless 

o 8 = On Street Walking, interface type wireless 

o 9 = ON Street Motorized Wireless, interface type wireless 

o 0 – ON Street Walking Wireless, interface type wireless 

 



IMDAS RIMS Phase II User Guide   Version: 2.10 

Engineering  Package Technology and Visibility   Date:  April 29, 2014 

 

41 

 

Figure 36.Tracking Tab - MSP Scan Plotted on Map 
 

For each route ID where GPS data is available, the MSP report has a link to display, on a map, all the 
locations where MSP scans were performed. To view all MSP scan locations for a selected route, click on 
the hyperlinked route in the Route ID column.  The scan locations will appear as pins on the map.  The 
red pin shows the location of the most recent MSP scan.  The GPS information for a specific scan 
location is displayed in a scrollable pop-up box when the user clicks on one of the pins. The pop-up box 
can be closed by clicking on the “x” symbol in the upper right hand corner.   

 

Figure 37.Tracking Tab - MSP Scan Locations for Selected Route  

TO EXPORT MSP REPORT TO A CSV FILE: 
1.) On the MSP Records page, click the column header “…”. 
2.) A drop down box will display.  Choose option “Export to CSV”. 
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3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 
export CSV file. 

4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 
 

4.7.2 MSP Delta Report 
The MSP Delta Report compares today’s date MSP records with yesterday’s MSP records and highlights 
table rows with any discrepancies.  The following fields are included in the following order for each record 
in the report: 

 Previous Barcode ID 

 Previous Event Date Time 

 Previous User ID 

 Today’s  Barcode ID 

 Today’s Event Date Time 

 Today’s User ID 

 Route ID 

The MSP Delta Report is presorted first by Route ID, then Today’s Event Date/time, and then Barcode ID. 
No columns in the MSP Delta Report are sortable.  The report can be exported to a CSV file.   

 

Figure 38.Tracking Tab - MSP Delta Report 

EXPORT MSP DELTA REPORT TO A CSV FILE 
1.) On the MSP Delta Report page, click the header “…” 
2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 
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4.7.3 CPMS Records 
The Collection Point Management System (CPMS) shortcut allows the user to view CPMS scan records 
for the current Location (System ID).  On selecting the shortcut, all CPMS scan records for the current 
date are displayed.  The records are displayed in ascending order based on the Event Date and Event 
Time taken from the CBL record.  CPMS records for other dates may be viewed by entering the desired 
dates in the date text boxes and clicking on Search.  It is also possible to selectively view all CPMS scan 
records for a particular Route.  This is done by entering the route number in the Route text box and then 
clicking on Search.   

The USPS CPMS Application is accessible from the CPMS Record Report by clicking on the hyperlinked 
“CPMS Application” above the Record Search box.  The CPMS Application will open on a new page. 

All RIMS CPMS records contain the same twenty two data elements taken from the CBL record and the 
associated header record (MEH).  CPMS records are stored on the RIMS for fourteen days.  Records 
older than fourteen days are deleted.  If CPMS data is required for future reference, the user has the 
option of exporting the current records to a file in CSV format.  The exported file can be opened and 
viewed using EXCEL.  

The fields included in each CPMS record, their order within the record, and their source are shown below: 

 Barcode ID  

 Assignment ZIP  

 Event Date Time  

 Route ID  

 User ID  

 Employee ID) 

 Record Version  

 Record Version (MEH) 

 Event Date Time (MEH) 

 Finance Number  

 SFAS Number  

 Unit ZIP  

 Device ID  

 Software Version  

 Operating System Version  

 BIOS Version  

 Transmission Date Time  

 Vehicle ID  

 Vehicle Begin Mileage  

 Vehicle End Mileage  

 Delivery Mode  
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 Map 

The CPMS Records page is searchable by any of these three fields: 

 Route ID 

 Start Date (default to today’s date) 

 End Date (default to today’s date) 

 

The figure below is an example of the CPMS Records page showing CPMS records for the current date. 

 

Figure 39.Tracking Tab - CPMS Record Report 
 

Each record that has GPS data associated with it has a link (called “Map” in the Map column).  Clicking 
on the “Map” link displays the location on a map where that CPMS record was scanned.   The location is 
marked with a red pin.  Clicking on the red pin displays a scrollable pop up box with geo-location data 
details about the location.  To close the pop-up box, click on the X symbol in the upper right hand corner.  
The pop-up includes the following fields: 

 Label ID 

 Route ID 

 User ID 

 Geo-location Date and Time Stamp 

 Accuracy (feet) 

 Latitude 

 Longitude 

 Method  
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o 0 = obtained between first scan and commit 

o 1 = obtained after empty records were created 

o 2 = obtained from previously received data 

 Delivery Mode 

o 1 = In Office 

o 2 = On Street Motorized 

o 3 = On Street Walking 

o 4 = On Street Motorized Wireless, interface type cradle 

o 5 = On Street Walking Wireless, interface type cradle 

o 6 = In Office, interface type wireless 

o 7 = On Street Motorized, interface type wireless 

o 8 = On Street Walking, interface type wireless 

o 9 = ON Street Motorized Wireless, interface type wireless 

o 0 – ON Street Walking Wireless, interface type wireless 

 

For each route ID where GPS data is available, the CPMS report has a link to display, on a map, all the 
locations where CPMS scans were performed. To view all CPMS scan locations for a selected route, click 
on the hyperlinked route in the Route ID column.  The scan locations will appear as pins on the map.  The 
red pin shows the location of the most recent CPMS scan.  The GPS information for a specific scan 
location is displayed in a scrollable pop-up box when the user clicks on one of the pins. The pop-up box 
can be closed by clicking on the “x” symbol in the upper right hand corner.   

The sample map views for CPMS data are similar to those shown for MSP data.  Refer to the MSP 
Records section to view these map examples. 

TO EXPORT CPMS REPORT TO A CSV FILE: 
1.) On the CPMS Records page, click the column header “…”. 
2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 

4.7.4 CPMS Delta Report 
The CPMS Delta Report compares current day CPMS records with previous day CPMS records for any 
discrepancy and highlights table rows that contain discrepancies.  Rows in the report with discrepancies 
are highlighted (or cells if possible). The following fields are included in the following order for each record 
in the report: 

 Previous Barcode ID 

 Previous Event Date Time 



IMDAS RIMS Phase II User Guide   Version: 2.10 

Engineering  Package Technology and Visibility   Date:  April 29, 2014 

 

46 

 Previous Employee ID 

 Today’s Barcode ID 

 Event Date Time 

 Employee ID 

 Route ID 

 

The CPMS Delta Report is presorted first by Route ID, then Today’s Event Date/time, and then Barcode 
ID. No columns in the CPMS Delta Report are sortable.  The report can be exported to a CSV file. 

 

Figure 40.Tracking Tab - CPMS Delta Report 

EXPORT CPMS DELTA REPORT TO A CSV FILE 
1.) On the CPMS Delta Report page, click the header “…” 
2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 

4.7.5 Wireless Daily Scan & GPS Status Report 
The Wireless Daily Scan & GPS Status Report provides the user with a report for the current day 
identifying  

1. The Routes in the current System ID that are transmitting GPS data to the RIMS and  

2. The method each Route used for uploading scan data to the RIMS, e.g., wireless, or via cradle.   

The following fields are included in each record in the report: 

 System ID 

 Route ID 
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 User ID (from scan record)/ Employee ID (from GPS record) 

 IMD ID ( from scan record) 

 Cell phone IMEI Number (from GPS record) 

 GPS (GPS data availability) 

 Upload via Cradle (Business data was uploaded when cradled) 

 Upload via Wireless (Business data was uploaded real time) 

 

The Wireless Daily Scan and GPS Status report is sortable by Route ID or User ID/Employee ID.  No 
other columns are sortable. 

There are two records in the report for each Carrier/Route ID pair, one associated with the cell phone and 
one associated with the IMD.  The first record includes System ID, Route ID, Employee ID, cell phone 
IMEI and a column labeled “GPS” indicating whether or not GPS data was received.  The second record 
includes the System ID, Route ID, User ID (from the IMD,) IMD ID (IMD serial number) and how scan 
data was uploaded to the RIMS (via cradle or via wireless communication).   

The “Total” line includes the total number of Routes shown on the report, the total number of Routes that 
are sending GPS data, the total number of Routes that uploaded scan data via cradle and the total 
number of Routes that uploaded the scan data wirelessly.    

 

 

Figure 41.Tracking Tab - Wireless Daily Scan & GPS Status Report 

EXPORT WIRELESS DAILY SCAN & GPS STATUS REPORT TO A CSV FILE 
1.) On the Daily Scan & GPS Status by Route ID page, click the header “…” 
2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 

4.7.6 Wireless Users and Routes 
The Wireless Users and Routes shortcut opens the Summary of Wireless Users and Routes page.  This 
page displays the number of users and number of routes associated with the current System ID that are 
transmitting GPS tracking data for the day.   
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The displayed report includes a record for each Employee ID/Route pair.  The record includes the time 
the RIMS last communicated with the device held by the Employee ID/Route pair and the last time the 
RIMS received GPS data from the Employee ID/route pair.  The report includes the following fields: GPS 
Timestamp, Last Connection Timestamp, Route ID and Employee ID.  The table is searchable by either 
Route ID or Employee ID.  The default order of the records is by most recent GPS timestamp.  Records 
with no GPS timestamp (blank entry) precede those records that do have a GPS timestamp.  This helps 
the Supervisor quickly identify those Routes that are connected but not sending GPS data.  All of the 
columns are sortable in ascending or descending order.  

The report is exportable to EXCEL in CSV format for offline processing and reporting. 

Employee ID is a hyperlinked field.  The user can click on an Employee ID to map the employee tracks if 
there are valid GPS coordinates available. If the GPS Timestamp field is blank, if there are no valid GPS 
coordinates for the user’s last known geo-location and consequently no hyperlink for the Employee ID. 

The red pushpin icon on the displayed map indicates the current location of the employee. 

 

 

Figure 42.Tracking Tab - Summary of Wireless Users and Routes 

TO EXPORT SUMMARY OF WIRELESS USERS AND ROUTES TO A CSV FILE: 
1.) On the Wireless Users and Routes page, click the column header “…”. 
2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 

TO SEARCH THE SUMMARY OF WIRELESS USERS AND ROUTES: 
1.) Enter a Route ID or Employee ID in the Search panel. 
2.) Click the Search button to execute the search or the Clear button to start over. 
3.) Only records matching the search criteria will be displayed.  

TO VIEW THE MAP ROUTE TRACKS FOR A PARTICULAR USER: 
1.) Click on any hyperlinked Employee ID in the Summary of Wireless Users and Routes table. 
2.) The Map Route Tracks page will open, displaying the selected user’s bread crumb tracks for the day. 

2a.) Note: Please see Map Route Tracks” for detailed screen shots and user instructions. 
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4.7.7 Wireless Devices 
The Wireless Devices link in the Shortcuts section opens the Wireless Devices page.  This page displays 
the number of cell phones paired with IMDs that are transmitting for the current day.   

The displayed report includes identifying information about each cell phone associated with the current 
System ID that has been paired with an IMD at least once, and the last time it successfully communicated 
with the RIMS.  Up to two hundred device records are displayed on a scrollable page.   

The following information about each cell phone is displayed in the report:  

 Device Timestamp (Date and Time of last communication with the RIMS) 

 Device ID 

 Phone number 

 SW Version 

 FW Version 

 Passkey Version 

 SIM ICCID (future use by cell phone) 

 

The cell phones with the most recent Device Time Stamp will be at the top of the list by default.  All 
columns in the results table are sortable.  The device records are searchable by Phone Number.   

 

Figure 43.Tracking Tab - Summary of Wireless Devices 

TO SEARCH THE WIRELESS DEVICES LIST FOR A SPECIFIC PHONE NUMBER 
1.) Enter all or part of a Phone Number in the Search panel’s Phone Number text box. 
2.) Click Search to execute the search or clear to start over. 
3.) All records with phone numbers that match the entered criteria will be displayed. 

TO EXPORT WIRELESS DEVICES LIST TO A CSV FILE 
1.) On the Wireless Devices page, click the column header “…”. 
2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 
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4.7.8 Map Route Tracks 
The Map Route Tracks feature enables the RIMS user to view the tracks (breadcrumbs) and current map 
location of a single wireless IMD for a day or part of a day.  The user may select the wireless IMD tracks 
to view by Route ID, cell phone Device ID (cell phone IMEI number), Phone Number, or Employee ID.   

To the right of the search fields are the Map and Map Last Available Day buttons. Clicking on Map Last 
Available Day displays the most recent set of tracks for the device based on the search criteria entered.  
The system will fill in the date information to correspond with the track information displayed.  The user 
may also specify a time range to view the route track information for the selected day. 

Clicking on the Map button will display the set of tracks for the device for the date shown in the Date text 
box that also meets other selected search criteria.  The default date is the current date.     

The Basemaps pull down box in the upper right hand corner of the map permits the user to select the way 
the map is displayed.  Options are Road, Aerial and Topographic.  The Road view is shown on most of 
the maps in this section.  The Aerial view is a satellite view of the map.  The Topographic view shows 
land elevation, structures like buildings, as well as roads. 

 

 

Figure 44.Tracking Tab - Map Route Tracks 
 

HOW TO SEARCH FOR TRACKING INFORMATION FOR A PARTICULAR DAY 
1.) Select the method for identifying the specific user/device to be tracked.  Any one of four categories 

can be selected: Route ID, Device ID, Phone Number or Employee ID.  Click the drop down box next 
to “by” and select one of the options. 

2.) Once the Category is selected, enter search criteria relevant to the Category.  For example, if you are 
trying to find the tracking points for a specific route, type in the complete Route ID or part of the Route 
ID and then select Search.  Examples of search criteria for Route are “R004”, “R”, C0123, and “C”.     
2a.) The drop down menu below the Search box will be populated with routes that match the criteria 

entered.  If you type “R”, all Routes that include “R” in its description will be displayed.  Click the 
arrow on the right hand side of the drop down to see available matches.  Select one of the routes 
listed.          
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2b.) The option selected will be displayed in the “Select search result” box 
3.) Enter date by clicking on the date box and selecting a date on the pop up calendar.  Use the forward 

and back arrows on the calendar to select a month different than the one displayed.  . 
4.) Enter time criteria (if desired) by using the drop down boxes provided. 
5.) Click on the Map button to view results. 
 
NOTE:  the search function for Route is case sensitive.  “r004” will not find “R004”.  Entering just an “R” 

will display all of the routes started with the letter “R” in the drop down menu.  Entering an “r” will 
display all route names that include the lower case letter “r”. 

 

Figure 45.Tracking Tab - Map Route Tracks – Search Functions 
 

The wireless IMD tracking data will display on the map as a series of ‘pins’.  The green pin indicates the 
first track point.  The most recent user track point will display as a red pin.  The intermediate track points 
display as blue pins.   

 

 

Figure 46.Tracking Tab – Map Route Tracks Breadcrumbs 

Older Track Points 

Most Recent Track Point 

Enter Search Term 

Enter Search Category  Specify Date and Time Constraints  

Map based on Search Terms, Category and Date/Time 

Map Most Recent Day based on Search Criteria 

Starting Track Point 
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Under the Map buttons is a check box called Enable Route Order Numbering.  This function allows the 
user to see the tracks in chronological order, with 1 being the first GPS point of the day and the highest 
number being the most recent point.   

 

Figure 47.Map Route Tracks – Route Order Numbering Enabled 
 

Clicking on any of the pin icons, called a Track Point, opens a pop up box with Employee ID, Route ID, 
Device ID, Time, Speed, Accuracy, Latitude, Longitude, Distance, Method and Valid information for that 
Track Point. This information is also available from the Wireless Users and Routes Shortcut by clicking on 
the hyperlinked Employee ID field. 

 

Figure 48.Tracking Tab - Map Route Tracks Pop-Up Box 

Track Point Pop-Up 
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HOW TO MAP THE LAST AVAILABLE DAY 
1.) Determine the identification method for tracking the specific user/device. To select an identification 

method, pick one of the four options: Route ID, Device ID, Phone Number or Employee ID.  Click the 
drop down box and select one of the options. 

2.) Enter search criteria.  For example, if you are trying to map the last available day of Employee ID 
123456789004, enter that information in the Search box and select Search. 
2a.) The drop down box below the Search box will populate.  Click the arrow on the right hand side of 

the drop down box to see available matches.  Select one of the options. 
3.) Click the Map Last Available Day button. 

3a.) The last available Tracking Points for the selected user/device will display on the map. 

4.7.9 Map Addresses and User Location 
The Map Address & User Location Shortcut link opens the Map All Users with Addresses page.   

The RIMS user will be able to view all wireless IMD locations for the current System ID (delivery unit) on a 
visual map and a selected delivery or pick-up address at the same time. When first opened, this page 
displays the last location of wireless IMDs on a map for the current day.  The wireless IMD locations on 
the map are indicated by RED pins. The Route IDs can be displayed for each IMD on the map by 
checking () the Enable Labels box.  The pick-up address entered will be indicated by a BLACK Mail Box 
pin.  Checking () the Enable Labels box also displays the address of the Mail box pin above the Mail 
Box. 

The Map Addresses and User Locations screen is viewable as either road (default view), aerial (satellite 
view) or topographic view.  Change the map type by clicking on the drop down box called “Basemaps” in 
the upper right corner of the map. 

 

 

Figure 49.Map Address and User Location – Enable Labels 
 



IMDAS RIMS Phase II User Guide   Version: 2.10 

Engineering  Package Technology and Visibility   Date:  April 29, 2014 

 

54 

Once the user enters an address and clicks on Find Address, a numbered list of matching locations will 
be shown to the left of the map. The user can then select the appropriate address. Once the address is 
selected, the map will refresh with the selected address appearing in the center of the map. 

 

 

 

Figure 50.Map Address & User Locations - Pick-up Address Matches 
 

The identifying information for each wireless IMD user will be displayed when the user clicks on a red pin. 
Employee ID, Route ID, Device ID, time, and geo-location data will be available in a scrollable pop-up 
box. The pop-up can be closed by clicking on the “x” symbol in the upper right hand corner.   

 

Complete address 

Potential address matches 
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Figure 51.Map Address and User Locations – Last User Location 
 

The address information for a Mail Box location will be displayed when the user clicks on a black Mail Box 
pin.  Note that the red pin just above the mailbox is the user closest to the selected address.  Clicking on 
that red pin would display the identification information for that Carrier. 

 

 

Figure 52.Tracking Tab - Map Address & User Location – Location Detail 
 

HOW TO FIND A LOCATION 
1.) In the Pick-Up Address text box, type an address and press Enter or click the “Find Location” button to 

the right of the text box. 
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1a.) Include street address, city, state and Zip Code.  More address information provided in the Pick-
Up Address text box will return a better result. 

1b.) Example: “123 Main St, Portland, OR, 20000”, “Portland, Oregon” but not “Portland” or “OR” 
2.) A list of potential matches will appear on the left side of the screen. 

2a.) Choose the most appropriate address and the map will zoom in and re-center to the chosen 
location. 

 

HOW TO FIND INFORMATION ABOUT AN IMD USER 
1.) Click on one of the red push pin icons 

1a.) A pop-up box called Last User Location appears 
2.) Scroll down the pop-up box to see the information for that user 

2a.) Information includes Employee ID, Route ID, Device ID, Time, Speed, Accuracy, Latitude, 
Longitude, Distance, Method and Valid. 

2b.) Note: Click the ‘X’ in the upper right corner of the pop-up box to close the pop up or click on a 
different red pin to switch to a different Last User Location.  Use the scroll on the mouse or the 
scroll bar on the right hand side of the pop-up to see all of the information. 

2c.) Note: The Method information identifies how the point was obtained.  0 indicates GPS and 1 
indicates the points were obtained by cell towers. 

HOW TO FIND DETAILED INFORMATION ABOUT A LOCATION 
1.) Find a Mailbox icon, which represents a location 
2.) Click on the Mailbox icon 

2a.) A pop-up box called ‘Location’ appears 
2b.) Pop-up contains Address, Score, and Source Locator Information. 
2c.) Note: Score indicates how closely the selected location matches the address entered in the Pick-

Up Address box. 

 

4.7.10 GPS Locations 
The GPS Locations shortcut opens the GPS Locations page.  This page displays the most recent GPS 
data in a searchable table.  GPS records are stored on the RIMS for thirty days.  GPS records older than 
thirty days are deleted.  Any or all of the records can be displayed.  The records in the table include the 
following fields: 

 Device Event Time 

 Posting Time 

 Latitude 

 Longitude 

 Employee ID  

 Route ID 

 Device ID 
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 Phone Number 

 Speed (miles per hour) 

 Direction (0-359) 

 Distance (from cell phone initial coordinates in miles) 

 Accuracy 

 Location Method (GPS=0 or Cell Tower = 1) 

 Location Valid (true = 1 or false = 0) 

 Extra Info (any additional information if location is invalid above) 

All of the columns in the table are sortable in both ascending and descending order.  Device ID entries 
are hyperlinked and connect to the Map Route Tracks page.  Clicking on a device hyperlink displays the 
route tracks for that device for the date indicated in the timestamp. 

Above the table is the Record Search panel.  Users may conduct a record search by using any of the 
following fields:  

 Device ID 

 Employee ID 

 Route ID 

 Start Date 

 End Date 

The Device ID, Employee ID and Route ID are text fields where the Supervisor may enter all or part of the 
text to be searched. If there are no GPS records available that match the selected criteria for the 
requested time frame, the area below the Record Search area will contain the message:  “Results: No 
items found”. 

 

 

Figure 53.Tracking Tab - List Raw GPS Data 
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HOW TO USE THE RECORD SEARCH 
1.) From the GPS Locations page in the Tracking Module, find the Record Search fields above the GPS 

Locations table. 
2.) Enter search criteria in any of the following fields: 

2a.) Device ID, Employee ID, Route ID 
2b.) Note: The search fields are case sensitive, free form partial searches.  For example, to search for 

Route ID “R004”, “r004” will not return any results.  Entering a partial Route ID of “R” in capital 
letters returns matching Route IDs including “R” but not “r”.   

3.) Click on the Start Date and End Date boxes and select a date from the displayed calendar. 
3a.) When there are no specified dates, the Start and End dates will default to the current date. 

4.) Hit “Enter” on your keyboard or click the ‘Search’ button to the right of the Record Search fields 
4a.) Results will display in the GPS Locations table below the Record Search fields. 

DISPLAY LOCATION OF SELECTED DEVICE ON A MAP 
1.) From the GPS Locations page, find the Device ID column in the GPS Locations table. 
2.) Select a Device ID by clicking on the hyperlinked entry.  
3.) The Map Route Tracks page will open for the selected Device ID for the date identified in the Device 

Time column.  See Section 4.7.8 for detailed screen shots.  The tracks displayed will be from start of 
day up until the time indicated in the Device Time column. 

HOW TO EXPORT GPS RECORDS TO A CSV FILE 
1.) From the GPS Locations page in the Tracking Module, click on the column header “…”. 
2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 

 

 

Figure 54.Tracking Tab - GPS Locations - Open or Save Exported CSV File 
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4.8 Special Tab 

The Special Tab provides the user with access to Special Reports.  These include the USPS End of Day 
report and the RIMS Manual Entry Report.    Access these two reports using the Shortcut links on the left 
side of the screen.  

   

 

Figure 55.Special Tab - Default Screen 

4.8.1 End of Day Report Link 
Selecting the End of Day Report link takes the user to the USPS End of Day Report website.  To return to 
the RIMS, the user must press the back arrow on the left upper corner of the browser.  

 

4.8.2 Manual Entry Report 
The Manual Entry Report provides the user with a report listing the labels that were entered into an IMD 
using the Manual Input option.  The report includes only the manually entered labels for a single Location 
(System ID).  The fields displayed on the report include: 

 Label ID 

 Route ID 

 Event Date Time 

 User ID of person making the entry 

 

The Manual Entry Report provides the following search fields: 

 Label ID 

 Start Date (default to today’s date) 

 End Date (default to today’s date) 
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Figure 56. Special Tab - Manual Entry Report 

TO SEARCH FOR A LABEL ID 
1.) Enter a Label ID in the Label field 
1.) Set a Start Date and an End Date 
2.) Click Search to execute the search. 

 TO EXPORT THE MANUAL ENTRY REPORT TO A CSV FILE 
1.) From the Manual Entry Report page, click the column header “…”. 
2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 
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5 Area User Role 
The Area User has access to the following Tabs: 

 Home 

 Reports (system based module) 

 Tracking (system based module) 

 Area (area based module) 

 Special (system based module) 

Only these five navigation tabs will visible to the logged in Area Coordinator user. 

5.1 Home Tab 

When the Area user logs on to the RIMS, the Area Home Tab is the first page displayed.  The user can 
view the Scan reports, Tracking reports, and Special reports for any of the System IDs within the Area 
(one at a time).  To select the System ID to view, depress the down arrow under Set Default System ID.  
The names of all the System IDs in the Area will be displayed in ascending order on the pull down menu.  
Select the one to be viewed and then click Set.  The screen will refresh and the selected System ID will 
then be displayed in the Welcome banner. The User can also view a custom Area report. 

 

   

Figure 57.  Area User Home Tab 

5.2 Reports Tab 

See Section 3.3 for description of Reports Tab. 

5.3 Tracking Tab 

See Section 4.7 for description of the Tracking Tab 
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5.4 Area Tab 

The Area Tab allows the user to view the Wireless Daily Scan and GPS Status Report by District.   The 
following information is displayed on the report: 

 District Name 

 GPS (number of cell phone devices sending GPS data) 

 GPS/Wireless (percentage of cell phone devices sending GPS that also sent IMD scan data 
wirelessly) 

 Cradled (count of IMD devices that transmitted scan data by cradle) 

 Wireless (count of IMD devices that transmitted scan data wirelessly) 

 Wireless/Total Routes (percentage of routes that sent scan data wirelessly) 

 Total Routes (count of all routes, cradled or wireless, transmitting scan data) 

 

The screen shot below shows the fields included in each record. There is one line entry for each District 
in the Area.  The report is sortable by District. The Area user can export the report to a CSV file.  

 

 

Figure 58. Area Tab - Wireless Daily Scan and GPS Status Report 
 

If the Delta GPS/Wireless is greater than 100%, then most likely the carrier had no labels/packages to 
scan.  If the Delta GPS/Wireless is less than 100% then most likely there was a satellite coverage issue.  
If the GPS/Wireless field displays “Inf”, this indicates that the Wireless count was 0 so the result of the 
division is undefined. 

EXPORT WIRELESS DAILY SCAN & GPS STATUS REPORT (BY DISTRICT) TO CSV 
1.) Click the column header “…”. 
2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 

5.5 Special Tab 

See Section 4.8 for a description of the Special Tab 
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6 District User Role 
The District Coordinator User has access to the following Tabs: 

 Home Tab 

 Reports Tab 

 Config Tab 

 Tracking Tab 

 District Tab 

 Special Tab 

Only these five navigation tabs will be visible to the logged in District user. 

6.1 Home Tab 

When the District user logs on to the RIMS, the District Home Tab is the first page displayed.  The user 
can view the Scan reports, Tracking reports, and Special reports for any of the System IDs within the 
District (one at a time).  To select the System ID to view, depress the down arrow under Set Default 
System ID. The names of all the System IDs in the District will be displayed in ascending order on the 
pull down menu.  Select the one to be viewed and then click Set.  The screen will be refreshed and the 
selected System ID will then be displayed in the Welcome banner.  The user can also a view custom 
District report. 

 

 

Figure 59.District User Home Tab 

6.2 Reports Tab 

See Section 3.3 for description of Reports Tab.   

6.3 Config Tab 

See Section 4.6 for description of Config Tab.   
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6.4 Tracking Tab 

See Section 4.7 for description of Tracking Tab. 

6.5 District Tab 

The District Tab allows the user to view the Wireless Daily Scan and GPS Status Report by System ID.  
The following information is displayed on the report: 

 System ID 

 GPS (number of cell phone devices sending GPS data) 

 GPS/Wireless (percentage of cell phone devices sending GPS that also sent IMD scan data 
wirelessly) 

 Cradled (count of IMD devices that transmitted scan data by cradle) 

 Wireless (count of IMD devices that transmitted scan data wirelessly) 

 Wireless/Total (percentage of routes that sent scan data wirelessly) 

 Total IMDs  

 

Total Routes (count of all routes, cradled or wireless, transmitting scan data). The screen shot below 
shows the fields included in each record. There is one line entry for each System ID in the District.  The 
report is sortable by SYSID.  The District user can export the report to a CSV file. 

 

 

Figure 60. District Tab - District Wireless Daily Scan and GPS Status Report 
 

If GPS/Wireless is greater than 100% then most likely the carrier had no labels/packages to scan.  If 
GPS/Wireless is less than 100%, then most likely there was a GPS satellite coverage issue.  If the 
GPS/Wireless field displays “Inf”, this indicates that the Wireless count was 0 so the result of the division 
is undefined. 

 

EXPORT DAILY SCAN AND GPS STATUS BY SYSTEM ID REPORT TO CSV FILE 
1.) Click the column header “…”. 
2.) A drop down box will display.  Choose option “Export to CSV”. 
3.) A Microsoft prompt will display, asking the user to choose whether to Open, Save or Save As the 

export CSV file. 
4.) Choose “Save As”, enter a name for the file, and navigate to a local location to save the file. 
5.) Go to the saved file and open the CSV file as needed. 
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6.6 Special Tab 

See Section 4.8 for a description of the Special Tab. 
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7 Headquarters User Role 
The Headquarters User has access to the following Tabs: 

 Home Tab 

 Reports Tab 

 Tracking Tab 

 Special Tab 

Only these six Tabs will be visible to the logged in Headquarters User Role. 

7.1 Home Tab 

When the Headquarters user logs on to the RIMS, the Home Tab is selected and the user’s Home Page 
is displayed.  See Section 2.2 for detailed information about the Home Tab.   

 

Figure 61.Headquarters User Role Home Tab 
 

If the Headquarters user has been designated with Super User privileges, a different Home page will be 
displayed when the Home Tab is selected.  With Super User privileges, the user is not limited to viewing 
information for a limited number of System IDs, but can select any System ID that is supported by the 
RIMS.  The RIMS Super User also has ADMIN privileges.  See the figure below. 

SET OR CHANGE A DEFAULT SYSTEM ID FOR A SUPER USER 
1.) The default assigned System ID is visible in the Welcome Banner. 
2.) Type part or all of the desired System ID (e.g. SYSxxxxx) in the text box to the left of the grey Find 

button. You can also type part of a facility name to find the System. 
3.) System ID names will populate in the Set Default System ID drop down box.  Click on the drop down 

menu, select a System ID and click the grey Set button. 
4.) The screen will refresh and the new System ID will appear in the Welcome Banner. 
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Figure 62.Headquarters Super User Role Home Tab  
   

7.2 Reports Tab 

See Section 3.3 for a description of the Reports Tab. 

7.3 Tracking Tab 

See Section 4.7 for a description of the Tracking Tab. 

7.4 Special Tab 

See Section 4.8 for a description of the Special Tab. 
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Appendix A: Glossary 

Term Description 

AAU Arrival-At-Unit 

ACE Advanced Computing Environment 

BT Bluetooth 

CBL Collection Barcode Label 

CPMS Collection Point Management System 

CSV Comma Separated Value 

DU Delivery Unit 

EM  Express Mail 

EMCA Express Mail Corporate Account 

FW Firmware 

GPS Global Positioning System 

IM Intelligent Mail 

IMD Intelligent Mail Device 

IMDAS Intelligent Mail Data Acquisition System 

LAN Local Area Network 

LIM Local Intelligent Mail (Computer) 

MED Scan Barcode Event Record 

MEH Header Record 

MMD Managed Service Point Record 

MNS Managed Network 

MRC Mail Recovery Center 

MSP Managed Service Point 

NAS Network Access Server 

NIM National Intelligent Mail 

PMO Program Management Office 

PO Post Office 

RIMS Regional Intelligent Mail Server 

RM Registered Mail 

SAFR Standard Accounting for Retail 

SFAS Standard Field Accounting System 

STC Stop-The-Clock 
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Term Description 

SW Software 

USPS United States Postal Service 

WAN Wide Area Network 

 

 

   

 


